FORMATTING GUIDELINES FOR THE DEPAUL MCS MASTER’S THESIS OR THESIS PROJECT

CREATED 2012

If you have any questions, please contact your thesis committee or other MCS faculty for further clarity. Note: These guidelines are specific to the MCS program and do not necessarily apply to other DePaul programs of study.
ELEMENTS TO BE INCLUDED (AND IN WHAT ORDER):

1. Title Page (no page #-ing)
2. Dedication Page (no page #-ing)*
3. Acknowledgments (lowercase Roman numeral #-ing, starting at the number it would have been had you numbered the previous 2 elements)*
4. Abstract (lowercase Roman numeral #-ing)
5. Table of Contents (lowercase Roman numeral #-ing)
6. List of Illustrations (lowercase Roman numeral #-ing)*
7. Body of the Text (Arabic numerals, starting at 1)
8. Endnotes (Arabic numerals)
9. Appendices (Arabic numerals)*
10. Bibliography (Arabic numerals)

NOTE: Sample s of all front matter can be found at the end of this document

* - These elements of the thesis/thesis project are not required. Their inclusion will depend upon your preference (#2 & #3) and the specifics of your individual thesis/project (#6 & #9).

PROJECT VS. THESIS

The formatting for the thesis and project will be identical. Of course the body of the text for the project will be shorter. You will not have as many chapters. Be sure, however, that the title page and abstract page says “thesis project” instead of “thesis.”

TITLE PAGE

The title page will include your thesis’s or thesis project’s title, your name and currently held degrees, and information about the program you are completing.

DEDICATION

This page can include a brief dedication to whomever. This is usually just a few words.

ACKNOWLEDGMENTS:

The acknowledgments page (1 or 2 pages) gives you the opportunity to thank or acknowledge the contributions of whomever you would like in detail.

ABSTRACT:

The abstract provides a 150-200 word blurb to describe your project.
**TABLE OF CONTENTS:**

The table of contents (TOC) can either be manually created or created automatically (which is easier to format) within MS Word. If you choose to do the latter, you must give chapter titles and subheadings consistent and different “styles” throughout the document. For example, each main element (List of Illustrations, Introduction: Title of Introduction, Chapter 1: Title of Chapter 1, Chapter 2: Title of Chapter 2, Notes, Appendix, Bibliography) would have style “heading 1,” while subheadings of the same level would have style “heading 2” or “subtitle.” These style headings will generate the table of contents. If you choose to do this within MS Word, then the generated TOC will keep track of page numbers. If you make changes to the document after creating the TOC, MS Word can repaginate the TOC for you. Just follow directions within Word.

**LIST OF ILLUSTRATIONS:**

If your thesis or project paper has illustrations throughout, they should be numbered both by chapter and the number of illustrations (ex. The first illustration in chapter 1 would be Illustration 1.1; the first illustration in chapter 3 would be 3.1; etc.). After the number, the list of illustrations should include a brief description of the image (ex. Illustration 1.1: The cast of *Glee* appears on the red carpet of the Golden Globes). The list of illustrations, like the TOC, should include the accompanying page numbers of the images. You can also have MS Word automatically create this table if you use a unique “style” for the illustration numbers and descriptions within the document. Also like the TOC you can have MS Word repaginate if you make changes in your page numbers after creating the document.

**BODY OF TEXT:**

Each chapter, including the intro and conclusion, should include the chapter number and chapter title (ex. Chapter 1: *Glee* and Its Cult of Internet Fandom) on the first page of (not a separate page from) the body of the text itself.

**NOTES:**

*Citation info vs. notes* – All of this information should go in the same type of notes (preferably endnotes). You do not differentiate (when numbering) between an endnote created to illustrate the source being cited and additional information being provided.

*Endnotes over footnotes* – because of formatting issues within MS Word, endnotes are preferable over footnotes. Endnotes should start numbering at 1 with each new chapter (ex. Notes for chapter 1 start at 1, notes for chapter 2 start at 1, etc.). To accomplish this, you will need to make each chapter a new “section” within the document. You will then need to make sure (within the formatting of endnotes) that numbering starts over with each new section. For
ease of reading, please label each chapter’s notes with a new heading (ex. Chapter 1) before the notes for that chapter begin.

**APPENDICES:**

You may or may not have appendices included in your thesis or project paper. This could include a list of survey questions, charts, graphs, etc.

**BIBLIOGRAPHY:**

Your bibliography should include both texts that you directly cite and those additional texts that you may not cite but were directly relevant to the project. This could mean something that provided inspiration or direction but was not directly conveyed in the thesis or project paper, etc.

**MS WORD QUIRK:**

Because notes default to the end of the document, you have to toy with the program to add your appendices and bibliography after the notes (which is where they belong). Your choices are to either manually space to the next page after the notes and change the font to match the appropriate style (what you chose for your main text) or to create 2 different PDFs (one with the appendices and bibliography) that you combine after the fact. Whatever is easier to you is fine. They should both look the same.
ADDITIONAL FORMATTING INFORMATION:

MARGINS AND SPACING:

Main text – 11 or 12pt Times New Roman, double-spaced, margins no bigger than 1.25” and no smaller than 1”

Block Quotations (meaning any direct quotation that goes over 3 lines) – the left margin should be indented .5” from the left margin and the right margin should remain the same as the main text. These quotations should be single or double spaced, depending upon what style you use (MLA, Chicago, APA). (Additionally, these quotations should not have quotation marks unless for a quotation within the quotations.)

PAGE NUMBERING:

Early Front Matter – title page and dedication page have no page numbers

Subsequent Front matter (acknowledgements, abstract, table of contents, list of illustrations) – should have lowercase Roman numerals, starting wherever they should after the earlier front matter. For example, if you have one page of dedication and one page of title page, then your acknowledgements should start with lower case Roman numeral 3 (iii).

The Rest of the Thesis/Project Paper (all chapters, notes, appendices, bibliography) – start with Arabic number 1 and continue on every page. Make sure all pages are numbered consecutively through the end of the document.

CITATION STYLE:

Endnotes and bibliographies should follow the most updated versions of either APA, Chicago, or MLA citation style. For citation within the document, you may choose to use either an in-text citation method or endnotes. This is up to the discretion of the student. Regardless, the style used for those citations must match the style used in the bibliography.

THE FINAL DEPOSITED PRODUCT:

You will ultimately turn in a fully formatted copy of your document, free of errors, and saved in a PDF format to the graduate advisor, along with a fully signed “Defense Form,” “Author Submission Agreement Form,” and an “Abstract and Keyword Form” (all available on the MCS Thesis/Thesis project webpage).
A *Glee*-ful Experience for All
Musical Narrative and the Cult Fandom of *Glee*

by

Evelyn S. Franklin, B.S.

Thesis
Presented to the Faculty of the Graduate School of
DePaul University
in Partial Fulfillment
of the Requirements
for the Degree of

Master of Arts
in
Media and Cinema Studies

DePaul University
June 2012
Dedication

To Matthew Morrison for
the Inspiration of His Sweater Vests
Acknowledgements

I would like to thank my parents for instilling within me a love of television and a love of music. Without their support and guidance, this project would not have been possible....

This project could not have been completed without the help and dedication of the Gleeks of www.gleekdom.com. Their dedication to the show and willingness to share their experiences and community made this process possible....

Finally, I would like to thank my thesis committee, ....

February 29, 2012
Abstract

A Glee-ful Experience for All
Musical Narrative and the Cult Fandom of Glee

By
Evelyn S. Franklin, B.S.
DePaul University, 2012
Thesis Advisor: Whomever
Committee: Whomever Else

This thesis interrogates the interaction of the musical narrative and cult fandom of the television show Glee. First appearing on the American FOX television network in 2009, the show immediately found a strong and vocal fan base—both online and off. Quickly dubbed “Gleeks,” these fans took to the Internet—via fan sites, the FOX site, YouTube, etc.—to express their fandom, build on the emergent musical narrative, and share in their personal engagement with the stories and songs. As a uniquely musicalized fictional television show, Glee provides audiences with a potential dual catharsis built on both musical performance and dramatic—in this case teen melodramedy—storylines. Through lenses of television genre, musical affect, fan studies, and identity politics, this project examines the burgeoning Gleek community and its immediate and emergent ties to and investment in narrative specificity, music fandom, identity formation, and network-driven cross-promotion.
## Table of Contents

List of Illustrations................................................................................................................................................. x

Introduction: *Glee*, Genre, Musical Mayhem, and Fandom.......................................................................................... 1

  Introduction................................................................................................................................................................. 1

  Review of Literature...................................................................................................................................................... 8

    Television and Genre.................................................................................................................................................. 9

    Music on Television.................................................................................................................................................. 14

    Fan Participation...................................................................................................................................................... 18

  Methodology.............................................................................................................................................................. 22

  Outline of Chapters..................................................................................................................................................... 24

Chapter 1: *Glee*, Genre Blending, and “Hip?” Programming.......................................................................................... 26

Chapter 2: *Glee*, Musical Performance, and the Generational and Gendered Divide................................................... 50

Chapter 3: *Glee*, Online Fandom, and Musical Mayhem.............................................................................................. 75

Conclusion: After *Glee*................................................................................................................................................. 90

Notes.............................................................................................................................................................................. 110

Appendix A................................................................................................................................................................... 120

Appendix B................................................................................................................................................................... 122

Bibliography................................................................................................................................................................. 142

(Note: This can be created automatically by choosing specific heading styles from the Home menu. In Microsoft Word, under the References tab, choose Table of Contents. Program the levels you want to use and the heading styles that they will be represented by in your text [ex. Heading 2, Heading 3, Heading 4]. You can also choose to do this manually, just make sure that everything lines up aesthetically. These should include your title and main and subheadings within the text. Each chapter should be as detailed as the intro chapter is above.)
List of Illustrations

Illustration 1.1: Visual choices made within the series reflect a hybrid of the situation comedy and the classic television drama. ........................................................................................................35

Illustration 2.1-2.4: *Glee* Mash-Ups—aurally and visually—target both an older generation and younger one ..........................................................................................................................60

Illustration 3.1-3.5: The *Glee* Project website on Oxygen provides interactive spaces for fans to contribute content, interact with each other, and re-live their favorite *Glee* moments .......................................................................................................................................84

(Note: Like the Table of Contents, the List of Illustrations can be created automatically by defining a specific text style for your illustration headings. This can be created automatically by choosing specific heading styles from the Home menu. In Microsoft Word, under the References tab, choose Table of Figures. You can also choose to do this manually, just make sure that everything lines up aesthetically. Note that the illustrations are numbered by chapter and number within that chapter [Ex. 1.1]. You will start over with each chapter [Ex. 1.1, 2.1, 3.1, etc.].)

(Also note: Above I have listed both singular illustrations and a series of illustrations. A series can be used in cases where you may have had only one caption to describe a series of closely linked images. Use your judgment as to whether they should be separated [e.g. 2.1, 2.2, etc.]. If in doubt, just do an entry for each.)
Notes

Chapter 1: Introduction – What a Glee-ful Day

3 These comments are included in Altman’s introduction to Dyer’s essay “Entertainment and Utopia,” Altman, *Genre* 175.

Chapter 2: The Music of Glee: Fan Engagement and Creation

3 These comments are included in Altman’s introduction to Dyer’s essay “Entertainment and Utopia,” Altman, *Genre* 175.

(PLEASE NOTE: YOU START RENUMBERING AT 1 WITH EACH NEW CHAPTER OF NOTES, AND WITH EACH NEW CHAPTER YOU MUST GIVE THE FULL CITATION FOR A SOURCE, EVEN IF IT HAD BEEN USED IN A PREVIOUS CHAPTER. ALSO, YOUR FONT SIZE DECREASES HERE. MS WORD WILL LIKELY DO THIS ITSELF. IN THE EXAMPLE, REGULAR TEXT IS 12 AND NOTES ARE 10.)